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Fine Tuning Your Designs 

Now that you have taken the “EmbroideryWorks Basics” class and have a good working 
knowledge of the basics in this incredible program, you are ready to move on and explore 
the additional features EmbroideryWorks Advanced has to offer. This class is designed to 
give you an overview of the additional features that help you fine tune and take your designs 
to the next level...and make them better serve your project vision. Some of the 
EmbroideryWorks Advanced features included in this class are Stitch Editor; Perfect 
Placement, StitchPerfect processor; Advanced Design Splitting; and MORE! 

This class is an “Advanced” level class so it does get technical because of the nature of the 
options discussed. 

This class assumes you have already taken the Sew at Home “EmbroideryWorks Basics” Part 1 & 
Part 2 classes before taking this class. The basic features may be used in the class exercises but the 
fine points on how and why are not discussed in this class or handout. 

The designs used in the class exercises written in the handout are provided as part of the 
class unless otherwise indicated. They are provided as zipped files and you will need to 
unzip the files to use for class…you may even want to create a class folder so you know 
where to find your designs. 

All instructions are written as a left mouse click less otherwise instructed. 
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Opening Program: 

1. Open the EmbroideryWorks program by double clicking on the desktop icon. 

Activating your EmbroideryWorks Advanced features: 
You started by installing the EmbroideryWorks™ Everyday program and then the 
EmbroideryWorks™ Advanced program…but you can’t find the new advanced tools? You 
need to activate the license for the advanced tools using the advanced serial number to turn 
the additional tools on.  

1. Click on Help menu then select Serial Numbers…. The Serial Number Entry box will 
display. 

 If you have already activated the license for EmbroideryWorks™ Everyday then you 
would see the program and serial number 
listed in the box. 

2. Place your cursor in the Serial # field and 
enter your EmbroideryWorks Advanced 
serial number. 

3. Click the Set button. 
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 If you are opening the program for the first time and the field is blank, you will need to 
enter the serial number for both 
programs and Set each one.  

4. Click the Done button.  

5. The Please Restart box will display. Click 
OK button.  

6. There are two ways to close the program. 

a. Select the X in the upper right corner 
of the program screen. 

 
OR  

b. Select File menu, then Exit from the drop down menu. 

Stitch Editor: 
The ability to edit individual stitches, change how a design section stitches out (fill vs. 
column) and/or easily split sections of a design into a separate design can all be very useful 
options…and EmbroideryWorks™ Advanced allows you to do these and more using stitch 
editing.  

 Includes a variety of ways to select stitches including a sewing simulator. 
 Includes the ability to split a selected set of stitches into separate design. 
 Can change selected section stitching type to fill, satin, or 2 - 3 column fill. 

General information: 

 When the Stitch Editor mode is on: 
 The Tool Pane changes to the Stitch Edit controls. 
 The stitch points display automatically in the design(s) on your 

workspace. 

Good to know: 
 The Stitch Edit mode can be turned on with or without a design on your workspace. 
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 If you turn off the 3D : 

~ You will be able to see the jump-stitches.  

~ There are also arrows displayed on the jump-stitch and other 
stitching lines to indicate the direction of the stitches. This helps 
determine ‘before’ or ‘after’. The arrow on each stitch points toward 
the next stitch as the design would stitch. 

~ There are times when it is easier to see and/or select the stitches 
you want with the 3D turned off.  

 You may want to use such options as Lock and Hide option in the Object View to 
make it easier to select the stitches you want. 

 You must select one or more stitches or section of your design before using any of 
the stitch editing features. 

Selection options: 

There are 3 selection options: 

 Freehand select: this allows you to left click around a shape free-form. All 
stitches within the selected area are then highlighted (selected). 

 Rectangle select: this option allows you to left click and drag a selection box 
around desired stitches/areas. 

 Brush select: this option allows you to select stitches by holding down the left 
mouse button and sweeping the pointer along the stitches.  

 Sewing Simulator: you can use the simulator to help select individual stitch points.

 

Good to Know:  
 Your mouse pointer does not change or look different when the different 

select options are selected. The one indented indicates the one selected. 

For example here the Brush select is the one being used:  
 When a stitch point is selected, it is displayed or highlighted as a circle. 
 After stitch(s) are selected the selection tool automatically turns off. 
 Notice that you can see the direction of the stitches when you are zoomed 

in.  

Move backward or 
forward stitch by stitch 

Move arrow back and 
forth to move through 

the stitches 
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Other options on the Tool Pane: 

 Split into stitches: this option allows you to take the selected stitches and split 
them into a new/separate design. 

 Satinizer: this option allows you to change selected section stitch 
type. There are 4 options- fill, satin, or 2 - 3 column fill 

 There is a slider where you can adjust compensation to the selected 

stitches or areas.  

~ Adjusting this slider makes the outside stitches of stitches a bit longer (moving the slider 
to the right) or shorter (moving the slider to the left). 

Good to Know 
 Compensate can be useful when you have gaps in a stitch-out and would like to 

‘stretch’ the stitches together, thus reducing or eliminating the gaps. 
 You can also use Compensate to adjust the width of lettering you may have 

imported. 

Individual Stitches: 

 Once selected, a stitch(es) can be moved by click and dragging with 
a mouse movement.  

 Once selected, a stitch(es) can be deleted by a right click menu 

option or click the Delete button on your keyboard.  
 You can add a stitch(es) before or after the selected stitch by using 

the correct right click menu option, Insert Before, Insert After.  
 In the Help menu you will find under Stitch Editing (Advanced), a “Keyboard Shortcuts” 

list. This list has all the ways you can use your key board to moved and select stitch 
points using your keyboard. You may want to print this out for reference if you like using 
key strokes as you work. 

Exercise: Splitting a section into a new design: 

1. Use either the Open  icon or Merge stitch file  icon on the Toolbar. Locate the 
embroidery designs given with the class download. Specifics on the difference and how 
the Open and Merge stitch file options work is discussed the “EmbroideryWorks Basics – 
Part 1”, available both as an Interactive/Live or OnDemand/recorded Sew at Home 
class. 

2. Select XKIT3T02.pes (floral & berries) design and click the Open or Import button as 
needed.  

3. Zoom into the upper right hand section of the design using any zoom option needed. 
Zoom options are discussed the “EmbroideryWorks Basics – Part 1”, available both as 
an Interactive/Live or OnDemand/recorded Sew at Home class. 

4. Select the Stitch Edit mode  icon from the Toolbar. 
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5. Select the Freehand select  icon. 

a. Left click around the top green stem of berries and 
leaves.  

b. To de-select extra stitch points picked up by accident 
or to select a few you missed:  

~ Zoom in more as needed. 

1) Hold down the CTRL  key on your keyboard.  

2) Click the stitch points not wanted or were missed. 

~ You can also delete any extra stitches later. 

6. Select the Split into stitches  icon. 

 Notice that there are now 2 designs listed in the Objects view.  
 The new design is named “Split”. 

7. Select the #2 Split design in the Objects view. 

8. Select the Select Objects  icon.  

9. Right click on the workspace and choose Copy from the pop-up 
menu.  

Good to Know: 
 If you are still in Stitch Edit mode when you right click, the edit menu will be different. 

This menu will include a copy, but this will copy just the selected stitch(es) and not 
the whole design. 

10. Select the New  icon to open a new design page. 

11. Right click on the new page and choose Paste from the pop-up menu. 

12. OPTIONAL as needed: delete sections or stitches not needed: 

a. Click the + next to the design in the Objects view. 

b. Select any unwanted section(s) and click the Delete button on your 
keyboard. 

c. Use Stitch Editing mode options to delete individual stitches as needed. 

13. Save your new design version: 

a. Click the Save  icon.  

b. Navigate to where you want to save the design using the Save in: window. 
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c. Type your design name in the File name: field. Use Berries and Leaves section for 
this design. 

d. Choose your machine format, if different than what you set in the Preferences, in 
the Save as type: field. 

e. Click the Save button.  

Exercise: Converting stitches: 
We’re going change how our new design segment will stitch out by using the Satinizer…to 
truly customize our new design. 

1. Select the Stitch Edit mode  icon from the Tool Bar. 

2. Selecting the leaf sections: 

a. Select segment 1:1 from the Objects view. 

b. Hold down the CTRL  key on your keyboard and select segment 1:2 in the 
Objects view. 

3. Select Fill from the Satin: menu.  

 Notice how the stitch points move.  
 Notice the stitch points are no longer selected. 

 
4. Select segment 1:4 from the Objects view to select the red berries. 

5. Select 2 Column from the Satin: menu.  

 Notice how the stitch points move and there is a line of stitch points down the middle 
of each berry.  

6. Select segment 1:5 from the Objects view to select the pumpkin berries. 

 Select 3 Column from the Satin: menu.  
 Notice how the stitch points move and there are two lines of stitch points inside each 

berry.  
7. To get a better look at how the design now looks: 

a. Select the Select Objects  icon. 

b.  Click the Objects view Select All icon. 

WOW that so easy and look what a difference it made in how our design 
looks! 

Good to Know: 
 If your stitch points are still showing, then select the View menu, 

then de-select the Stitch Points.  
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8. Save your revised design with a new name: 

a. Click the File menu, then select Save As… (Stitch and Working) option.  

b. Navigate to where you want to save the design using the Save in: window. 

c. Type revised at the end of the current name making the new name “Berries and 
Leaves section revised” for this design. 

d. Click the Save button.  

Precise Position: 
 This advanced feature allows you to automatically reposition and align designs based on 

the position of the original design and an x and y axis coordinate. 
 There are 6 control buttons for Precise Position that helps determine where the selected 

design will be repositioned (left, right, center, top, bottom, and center). 

General information: 

 You will want to start by selecting and displaying the hoop you are planning on using 
for your project. This will make it easier for you to figure out which Precise Position 
button you want to use. 

 The three buttons on the top control the display of the x-axis (horizontal) position. 
The options are Left, Center and Right. For 
example if you selected the Left button, the 
display and placement will be based on left 
edge of the design. 

 The three buttons on the bottom control the 
display of the y-axis (vertical) position. The 
options are Top, Center and Bottom. For 
example if you selected the Bottom button, the 
display and placement will be based on bottom edge of the design.  

 The rulers along the top and left side of the design page can be VERY helpful in 
determining what you type into the blank position field. 

~ Notice the center of both rulers is “0”. 

~ To the left of center on the top ruler the numbers are all marked by a minus “-“and are 

considered negative numbers. 

~ To the right of center on the top ruler the numbers are considered positive numbers 

~ On the left ruler, below center the numbers are all marked by a minus “-“and are 

considered negative numbers. 

~ On the left ruler To the right of center on the top ruler the numbers are considered 
positive numbers 

Good to Know: 
 If you have your grid turned off, then with the hoop displayed you will see basically an 

“x and y” axis displayed. This can also be very helpful in figuring out which Precise 
Position button to use. 
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Exercise: General Precise Position example: 

1. Select the New  icon to open a new design page. 

2. If the hoop is not showing on the workspace, click View menu and then select Draw 
Hoop. 

3. If on, turn off the grid by clicking on the View menu and then de-select Draw Grid. 

4. Selecting the hoop: 

a. Select the Preferences  icon. 

b. Click Normal option for Hoop Style.  

c. Select the machine format, if different from what you have been using. For our 
exercise, select PES. 

d. Select the 200mm x 200mm. 

e. Click the Apply button, and then the OK button. 

5. Use either the Open  icon or Merge stitch file . Locate the embroidery designs 
given with the class download.  

6. Select Spring206.pes (frog) design and click the Open or Import button as needed.  

 Notice the frog is in the center of the hoop, centered at the zero on both the top and 
left ruler. 

7. Select the frog design. 

 Notice the Precise Position fields now also display 0” in both the 
horizontal and vertical fields. This is because it was placed in the 
center of the hoop. 

8. To move the frog to the upper left portion of the hoop:  

a. On the top row: select the Center button and type -3.75 in the top field. 

b. On the bottom row: select the Center button and type +3.75 in the bottom field.  

c. Click Enter  on your keyboard.  

~ Notice the frog has moved to the upper left corner but is shown on the hoop, not inside. 

d. On the top row: select the Left button.  

~ Notice the number in the field changes automatically because it is representing the 
number that was already there but based on the new position. 

e. Type -3.75 in the bottom field and click Enter  on your 
keyboard.  

f. On the bottom row: select the Top button and type +3.75 in the bottom field. 

g. Click Enter  on your keyboard.  

~ Notice the frog has moved to the upper left corner within the displayed hoop. 
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9. To move the frog to the lower left portion of the hoop:  

a. On the top row: select the Left button and type -3.75 in the top 
field. 

b. On the bottom row: select the Bottom button and type -3.75 in the 
bottom field. 

c. Click Enter  on your keyboard.  

10. To move the frog to the lower right portion of the hoop:  

a. On the top row: select the Right button and type 3.75 in the top 
field.  

b. On the bottom row: select the Bottom button and type -3.75 in the 
bottom field. 

c. Click Enter  on your keyboard.  

11. To move the frog to the upper right portion of the hoop:  

a. On the top row: select the Right button and type +3.75 in the top 
field.  

b. On the bottom row: select the Top button and type +3.75 in the 
bottom field. 

c. Click Enter  on your keyboard.  

Exercise: Using Stitch Editing design with Precise Position 
1. Select the Berries and Leaves section revised tab to go back to that design page. 

2. Turn on the hoop display if not showing, click View menu and then select Draw Hoop. 

3. Selecting the hoop: 

a. Select the Preferences  icon. 

b. Select the machine format, if different from what you have been using. For our 
exercise, select PES. 

c. Select the 100mm x 100mm. 

d. Click the Apply button, and then the OK button 

4. If on, turn off the grid by clicking on the View menu and then de-select Draw Grid. 

5. Select the design and click the Center design in hoop  icon. 

 Don’t worry if the Precise Position fields do not say 0”. One of the other buttons 
beside Center may be selected. 

6. Resize the design: 

a. Click on the Scale proportionally  icon to de-select . 
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b. Type 85.0% in the height field on the Tool Pane. Click Enter  on your 
keyboard.  

7. Moving to upper right portion of the hoop:  

a. On the top row: select the Right button and type +1.95 in the top field.  

b. On the bottom row: select the Top button and type +1.95 in the bottom 
field. 

c. Click Enter  on your keyboard.  

8. Right click and choose Copy from the pop-up menu. Right click and choose Paste 
from the pop-up menu. 

9. Moving to upper left portion of the hoop:  

a. On the top row: select the Left button and type -1.95 in the top field.  

b. On the bottom row: select the Top button and type +1.95 in the bottom 
field. 

c. Click Enter  on your keyboard.  

10. Click Flip horizontal  icon.  

11. Right click and choose Paste from the pop-up menu. 

 Remember you are pasting based on the original design placement in the upper right 
corner. 

12. Moving to lower left portion of the hoop:  

a. On the top row: select the Left button and type -1.95 in the top field.  

b. On the bottom row: select the Bottom button and type -1.95 in the bottom 
field. 

c. Click Enter  on your keyboard.  

13. Click Flip horizontal  icon.  

14. Click Flip vertically  icon.  

15. Moving to lower right portion of the hoop:  

a. On the top row: select the Right button and type +1.95 in the top field.  

b. On the bottom row: select the Bottom button and type -1.95 in the bottom 
field. 

c. Click Enter  on your keyboard.  

16. Click Flip vertically  icon.  
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17. OPTIONAL: Use the Color Sort feature to eliminate extra color changes. This feature is 
discussed in the EmbroideryWorks Basics – Part 2 Sew at Home class. 

18. OPTIONAL: Save the new design layout as desired.  

WOW what a nice frame type design with perfectly aligned designs. 

Advanced automatic stitch count adjustment tools: 

StitchPerfect: 

When you purchase an embroidery design they don’t really know what type of fabric you're 
going to stitch it on so they set the density, underlay and more based on an imaginary fabric 
called ‘normal’ fabric. The fabric you're stitching on may be quite different than that ‘normal’ 
fabric. This is where StitchPerfect is very useful because it automatically makes adjustments 
to your design. 

 The StitchPerfect system allows you to adjust your embroidery design so it will stitch out 
correctly based on a specific selected fabric type, fabric weight and stretch. 

 The StitchPerfect option is found in the Project Advisor. For general information about 
the Project Advisor you may want to attend either the Live or OnDemand version of 
EmbroideryWorks Basics– Part 2 Sew at Home class. 

Good to Know: 
 There are 23 project/fabric types to choose from. You will want 

to choose the one that is close to the fabric you are planning 
on stitching on. 

 There are 3 Fabric thickness (weights) to choose from: Light, 
Medium, and Heavy. 

 There are 3 Fabric stretch amounts to choose from: None, 
Some, A Lot. 

 There is a StitchPerfect button to apply the filters and one to 
‘un-do’ the filters.  

 Note, even though we are using just one design for our 
exercise, you could have many designs on the work space and 
StitchPerfect would make the adjustment for everything on the 
design page at the same time…you don’t even have to have 
anything selected. 

Exercise: StitchPerfect  

1. Select the New  icon to open a new page. 

2. Use either the Open  icon or Merge stitch file  icon. Locate the embroidery 
designs given with the class download.  

3. Select XKIT3T02.pes (floral & berries) design and click the Open or Import button as 
needed.  

 Notice the status bar shows that the design currently has 8955 stitches.  
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4. Using the StitchPerfect filter for Knit fabric: 

a. Click on the Project Advisor  icon.  

b. Open the project/fabric type: menu and select Knits. 

c. Open the Fabric thickness: menu and select Medium. 

d. Open the Fabric stretch: menu and select Some. 

~ The information about the recommended needle type & size, thread, and stabilizers 
(Topping and/or Backing) is displayed. 

~ Other information about what and how to embroidery on 
knits is listed in the main window. 

e. Select the Set Project button in the StitchPerfect box. 

~ Notice how the stitch count has changed.   

5. Let’s see another one, the StitchPerfect filter for Bath Towel: 

a. Click on the Project Advisor  icon. 

~ Notice, the program still shows the last used fabric type- Knits 

b. Open the project/fabric type: menu and select Bath Towel. 

~ Notice, the program changed the Fabric thickness and Fabric stretch menus. We are 
going to leave these settings at default. 

c. Select the Set Project  button in the StitchPerfect box. 

~ Notice how the stitch count has changed.   

6. Let’s see one more, the StitchPerfect filter for Lace: 

a. Click on the Project Advisor  icon. 

b. Open the project/fabric type: menu and select Lace. We’re going to leave the other 
settings at default. 

c. Select the Set Project  button in the StitchPerfect box. 

~ Notice how the stitch count has changed.   

Good to Know: 
 Each time you select the StitchPerfect Set Project button, EmbroideryWorks 

Advanced makes the adjustment based on the original design and not the already 
adjusted design so you get the best results possible. 
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 The Stitches tab in the Properties view includes controls (Use Automatic Settings, 
Limit Density) that use the project settings from the Project Advisor to also remove 
stitches.  

 When you select a new design page EmbroideryWorks remembers the last project 
setting chosen in the Project Advisor but will not make any changes to your design 
unless you chose StitchPerfect or one of the Stitch tab settings. 

7. What if you change your mind and you want the design(s) back to original: 

a. Select the No Project  button. 

~ Notice how the stitch count adjusts again. 

~ Note, don’t worry if the design stitch count is a few less stitches than the original design. 
This means that maybe another filter has removed the ‘missing’ stitches, but you won’t 
miss them when it stitches out. 

Additional Stitches tab options:  

EmbroideryWorks Advanced offers some additional Filters on the Stitch tab in the Properties 
box. These Filters help give you more control to what type of stitch count is adjusted in a 
stitch file. Each one preforms a different type of function. 

 There are 4 Filters on the Properties Stitches tab. 
 Two of the Filters work in conjunction with the setting chosen in the Project Advisor to 

adjust stitches: Use Automatic Settings, Limit Density. 

General information: 

 Use Automatic Settings: makes use of the 
Project Advisor project settings to identify the fabric 
type, thickness, and stretch. The needle 
penetrations/stitch count is adjusted according to 
these settings. 

 Limit Density: looks for stitches too close 
together, based on Project Advisor project settings. 
It adjusts each part of your design if necessary to 
adjust the density for the selected fabric. If a 
design is digitized too dense for a certain project-
this will help solve the problem. Keep in mind- 
certain combinations of fabric and stabilizer have 
‘limits’ on the number of stitches it will support and 
too many stitches can cause poor stitch quality 
and/or puckered fabric. Using the Project Advisor, 
the Limiter will reduce the stitch counts in the affected regions. 

 De-Clump: Within sewing a single color, areas sometimes have too many stitches 
overlapping and these areas form clumps of thread. This can cause a build-up on the 
back of the fabric and/or can cause loss of registration [where areas meet each 
other]. De-Clump reduces these stitches by removing stitches where a given color 
over sews itself. 
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 Remove Underlap (intra-design): A design can have sections that overlap for the 
purposes of registration. But many times these regions are a result of poor digitizing 
or over digitizing, what is often referred to as “Bulletproof Embroidery”. Within a 
design, as the stitching occurs in one area that will be covered by another later 
color/segment. Those overlapped stitches can often be removed and that is exactly 
what this option does.  

Good to Know: 
 Remove Underlap is different from the Remove Hidden Stitches feature. Remove 

Underlap removes stitches from within a design while Remove Hidden Stitches 
removes stitches where one design overlaps a completely different design.  

 These options are the filters that the Sweep tool uses, except Sweep will look at the 
whole workspace, not just one design at a time. If after you run a Sweep, you can 
look at the Stitches tab and apply additional filters that the Sweep deemed not 
needed. 

 You can select one or more of the Filters options as desired. 
 These features are very similar to the found in a previous Designer’s Gallery® 

program called DensityWorks™. 

Exercise: Adjusting stitches on the cardinal on a branch design 
To see how each of the Stitches Filters are different, we are going to apply a different filter 
to the same design 4 times 

1. Select the New  icon to open a new page. 

2. If the hoop is not showing on the workspace: click View menu and then select Draw 
Hoop. 

3. Selecting the hoop: 

a. Select the Preferences  icon. 

b. Click Normal option for Hoop Style.  

c. Select the machine format, if different from what you have been using. For our 
exercise, select PES. 

d. Select the Jumbo Frame 14” x 14”. 

e. Click the Apply button, and then the OK button 

4. Use either the Open  icon or Merge stitch file  icon on the toolbar. Locate the 
embroidery designs given with the class download.  

5. Select FA110.pes (cardinal on fruit branch) design and click the Open or Import 
button as needed. 

6. Select the design and click the Rotate 90 degrees counter clockwise  icon on the 
Tool Pane. 
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7. Moving the design to the top center of the hoop using Precise Placement:  

a. On the top row: select the Center button and type 0 in the top field. Note this 
may be already there by default.  

b. On the bottom row: select the Top button and type 6.80 in the bottom field. 

c. Click Enter   on your keyboard.  

8. We want 4 of these designs: 

a. Right click on the design and choose Copy from the pop-up menu. 

b. Right click on the design and choose Paste from the pop-up menu. 

c. Right click on the design and choose Paste from the pop-up menu. 

d. Right click on the design and choose Paste from the pop-up menu. 

~ Notice you now have 4 designs showing in the Objects view. 

9. Moving the design to the bottom center of the hoop using Precise Placement:  

a. Make sure you have the last pasted design selected. 

b. On the top row: you will not need to make any changes.  

c. On the bottom row: select the Bottom button and type -6.80 in the bottom field. 

d. Click Enter   on your keyboard. 

10. Evenly space the designs using the Distribute feature: 

 More information is discussed about the Align & Distribute options in the 
EmbroideryWorks Basics – Part 1 Sew at Home class. 

a. Click on the Select All  icon in the Objects view.  

b. Select the Align and Distribute  icon 

1) Select the Distribute tab.  

2) Select the Left on the vertical options (top row). 

3) Select the Bottom on the horizontal options (left 
row). 

4) Select Extent of hoop option. 

5) Click the Apply button. 

11. Setting the Project Advisor for Linen fabric: 

a. Click on the Project Advisor  icon.  

b. Open the project/fabric type: menu and select Linen. 
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c. We’re going to leave the other settings at default. 

d. Select the X in the corner of the Project Advisor box to close. 

12. Select the #1 design from the Objects view. 

13. Using the Stitches filters: 

a. Select the Stitches tab in the Properties box. 

~ Notice that nothing is selected in the Filters section. 

~ Notice the stitch count, 20779, on the status bar.  

b. Select Use Automatic Settings in the Filters section. 

~ Notice the new stitch count has decreased.  

~ Notice the options of De-Clump and Remove Underlap are no longer available. This is 
because these are part of the Use Automatic Settings option. 

14. Select the #2 design from the Objects view. 

15. Using the Stitches filters: 

a. Select the Stitches tab in the Properties box. 

~ Notice that the Use Automatic Settings is selected already in the Filters section, but has 
not been applied. 

b. De-select Use Automatic Settings in the Filters section. 

c. Select Limit Density in the Filters section. 

~ Notice the new stitch count.  

16. Select the #3 design from the Objects view. 

17. Using the Stitches filters: 

a. Select the Stitches tab in the Properties box. 

b. De-select Limit Density in the Filters section. 

c. Select De-Clump in the Filters section. 

~ Notice the new stitch count.  

18. Select the #4 design from the Objects view. 

a. Select the Stitches tab in the Properties box. 

b. De-select De-Clump in the Filters section. 

c. Select Remove Underlap in the Filters section. 

~ Notice the new stitch count.  

Now each of our 4 designs has a different stitch count, showing that each Filter has a 
different function and effect on the selected design. 
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Additional Program Preferences options: 

Adjustments – Sizing:  

When you resize a design in EmbroideryWorks, the program will automatically recalculate 
the stitches for you…more or less stitches accordingly. This recalculation of the stitches is 
very sophisticated and amazing bit of programming! With EmbroideryWorks Advanced there 
are some additional settings you can adjust so you can control the results for your specific 
project! 

General information: 

 Sensitivity: this slider is used to control how ‘close’ the program looks at the fills and 
satin stitched areas of the design.  

 Gap Reduction: is a filter that proportionally expands fills past their ends so that 
gapping or spaces between fills are minimized when a design is increased in size. 
What this means is it helps adjacent areas lessen gaps that might be occur when 
designs are enlarged. This option is selected by default. 

 The stitch length filters: these are used to prevent long and loopy stitches designs 
are enlarged; and when decreased, prevents small stitches from getting too small 
causing stitching in one placed or bunching up.  

~ There are 6 stitch length filters.  

~ The settings are broken out by stitch type because the handling of satin stitches 
differently from a fill pattern. 

~ There are separate slider adjustments for the minimum and maximum of each stitch type. 

~ Sat. Length is abbreviation for satin stitch length. 

~ Fill Length represents minimum or maximum stitching length in a filled stitch pattern.  

~ May not want to adjust the maximum Sat. Length longer than 10 mm. 
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 There is a Use Defaults  button to reset all adjustments back to ‘factory’ 
settings 

Good to Know: 
 If you have a design which has a lot of manually created special stitch effects [such 

as fancy fills], then you may want to adjust the Sensitivity higher. 
 You may want to adjust the Sensitivity higher if there are blended effects or 

‘feathered’ type stitching in the design. 
 If you decrease the setting for Max. Sat. Length, when satin stitches are increased 

past this stitch width; the satin stitch will automatically turn the stitching into 2 row 
column stitching. 

 IMPORTANT: remember to select Use Defaults  button after you have 
finished your design(s) and that workspace so the adjusted settings do not change 
other designs you resize on future projects. 

 These features are very similar to the found in a previous Designer’s Gallery® 
program called SizeWorks™ 

Advanced Design Splitting options: 
Refer to “EmbroideryWorks Basics – Part 2” class for the basics on how to split a design, 
how to print a placement template, and how to stitch things ‘back together’. In this section 
we are going to explore how EmbroideryWorks Advanced gives you the ability to create or 
customize your own hoop and hoop layouts.  

 ‘Virtual’ or Multi-fabric hoop means re-hooping the fabric multiple times as you 
embroider the different split design sections to complete the whole design or layout. 
When you create a new hoop, you can design it to simulate how you want to reposition 
your fabric for your stitching the ‘part’ back together.  

 When creating a new hoop, there are options needed for use with different machine 
brands, models and formats. 

 You can also edit an existing hoop. 

Good to Know:  
 You can create a new (regular hoop not for splitting) Normal-Hoop Style  ‘fake’ or 

‘virtual’ hoop to use in arranging your design(s) and then create the same hoop 
layout for splitting. 

 Create a new regular ‘fake’ or ‘virtual’ hoop the overall size you want your design 
layout to be and then use the Fit Hoop option to do a quick resize of your design. Fit 
Hoop is discussed in the “EmbroideryWorks™ Basics – Part 1” Live or OnDemand 
Sew at Home class. 

 May want to create one for ‘off brand’ hoops such as Magna Hoop. 

Creating a basic Normal hoop: 

These are the basic steps to creating a new Normal basic hoop. Reasons you may want to 
create a ‘fake’ Normal hoop: 
 It can be very useful to create ‘fake’ hoops when creating a layout or group of designs 

you want to fit into a certain size that may not be a real hoop size. 
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 So you can use the Fit Hoop feature to a specific size that is not an actual hoop. 

Exercise: Creating a basic Normal hoop 

1. Select the Preferences  icon.  

2. Select Normal from the Hoop Style box. 

3. Select the New  button and the New Hoop box will display. 

4. Make the following changes in the New Hoop box: 

a. Name: --type My Layout: 400 x 300 

b. Width (mm): --type 400 

c. Height (mm): --type 300 

d. Click the OK button 

 Notice now this new hoop is in the main list and 
can be chosen like any other hoop in the list. 

Good to Know: 
 It can be very handy to name the hoop something that indicated this is a hoop you 

created, as we have called the one in this exercise “My Layout”. 
 Use the name of the hoop brand. 

Editing an existing Hoop: 

To edit an existing hoop, follow these basic steps. 

Exercise: Editing a basic Normal hoop 

1. Select the Preferences   icon.  

2. Select Normal from the Hoop Style box, if not already selected. 

3. Select the hoop you want to change from the main list. For this exercise select My 
Layout: 400 x 300. 

4. Select the Edit  button and the New Hoop box will display. 

5. Make the following changes in the New Hoop box: 

a. Name: --type My Layout: 300 x 400 

b. Width (mm): --type 300 

c. Height (mm): --type 400 

d. Click the OK button 

 Notice now this revised hoop is in the main list with the new name. 
 Remember that if later you want the Height and Width numbers reversed you can 

always use the Rotate 90 option when choosing the hoop and don’t have to edit it-we 
are just using this as an example for our exercise. 
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Creating a new Multi-Position Hoop and what these settings mean: 

Remember, EmbroideryWorks Advanced program can be used in conjunction with most 
home and commercial machines. For that reason there are lots of options available when 
creating your own hoop layout. You may not need to use all of the options for the machine 
you embroidery on.  

 

 Hoop Name: is just what it sounds like. Type in whatever name you want to use-
something that makes sense to you. 

~ You may want to use some indication that this is a hoop you created and was not built in, 
such as “My” or your initials. 

~ You may want to include the overall sewing field number as part of your name. 

~ You may want to include the hoop used in your layout as part of the name. 

~ Don’t make the name too long or the whole name will not display in the hoop list. Use 
abbreviations and try not to use too many spaces. 

 File Type: choose the format of the machine that you’re going to stitch the design on.  

~ This list contains all the file types that can be saved in EmbroideryWorks. 

 Overall Size: You are trying to create a hoop layout that will accomidate your design 
size with at least a little extra room for the embroidery machine foot (known as foot 
clearance). EmbroideryWorks Advanced will do the math for you as you change 
settings in the Hoop Properties box.  

Good to Know: 
 When naming a hoop, don’t make it too long or it will not completely display in the 

hoop window. 
 You will need to know your overall design layout size in millimeters. If you keep your 

program set to display in inches, just double click on the size information displayed 
on the right side of the status bar and the information will then display in millimeters. 

 I recommend giving yourself at least a 5-10mm foot clearance when considering the 
overall size of your new hoop layout. For example if your finished design layout is 
256mm x 238mm, then you need the Overall Size to be at least 261mm x 243mm or 
larger. 

 As examples, use can always look at the default hoops and their settings. Select the 
hoop you want to look at and then the Edit button.  
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 Remember you do not need to always use your largest machine hoop, depending on 
your design layout size, you may want to create a layout using a smaller hoop. 

 It can be very helpful when creating your ‘virtual’ multi-fabric hoop, to use the Split 
into Hoop option to preview how the program is going to split your design. This option 
is discussed further in the “EmbroideryWorks™ Advanced – Exploring the Utility 
Menu” Sew at Home class.  

 Individual Field Size (mm):  this is the embroidery field (in millimeters mm) of the 
hoop you are planning to use for the project you're creating the hoop for. It is often 
the largest hoop for your machine.  

~ NOTE: this must represent a single hoop position. You DO NOT want to use information 
for a multi-position hoop here-it still represents the actual embroidery field your machine 
stitches. 

~ If you are unsure about this size, consult your dealer or machine manual. 

~ You can set up your hoop based on how you're going to hoop your fabric, vertical or 
horizontal. For example, 200 x 300 OR 300 x 200. What you type here will change the 
information for the Overall Size setting and also whether you will want to use Rows or 
Columns. 

 
 

 Rows: field specifies the number of times the hoop will be attached to your machine 
vertically.  

 

Good to Know: 
 For most multi-position hoops, the Rows: number is three.  
 For sliding hoops such as those made by Hoop-It-All, you will have to determine how 

many sections you want to embroider in and keep in mind that there should be a 
good overlap between adjoining sections.  
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 Columns: field specifies the number of points at which the hoop can be attached to 

your machine sideways. For most multi-position hoops, this number is one, but there 
are exceptions on the market. These are usually described as “Double-Wide”. You 
can also use the columns to indicate that you want to divide the design into 
horizontally-tiled segments. 

 Offset: this setting is how much each hooping will overlap the other hoopings…it is 
also the area where EmbroideryWorks Advanced will split the design. This is also 
known as the “separation value”.  

~ For example, the distance from needle-center of one hooping position to the needle-
center of the next hoop position. 

~ The Offset value should be set to allow the greatest possible overlap between the 
hoopings to allow for better splitting.  

~ This number is taken into consideration by the program as it adjusts the Overall Size field 
information.  

 Right-to-Left: field is used for multi-column hoops from manufacturers, sometimes 
known as “Double-Wide”. When selected it means that the initial direction the 
program will split the design will be right-to-left, as opposed to the standard, left-to-
right. The use of this depends on the machine and hoop manufacturer. Some 
manufacturers have wide hoops that start by sewing the left side of the design 
upside-down, then you turn the hoop halfway around and embroider the other side 
(now the right side, and the design is right-side-up).  

~ NOTE: You can tell if your separation figure is correct! The manufacturer of the hoop 
should provide you with the number of positions used as well as the full size of the 
embroidering region of the hoop. As you adjust the offset, the field. “Overall Size” is 
calculated. If this matches the figure given to you by the manufacturer, you have correctly 
set your separation. 

 Compensation: allows the final regions to be slightly increased in size. This forces 
the stitching of the regions to overlap each other. This is useful because as the 
machine adds stitches, the fabric pulls in and/or shifts slightly. You could have a gap 
between regions if no compensation is used.  

~ The amount of Compensation required depends on several factors: The size of the hoop, 
the fabric being embroidered, the number of stitches, the type of the stabilization, etc.  

~ The settings for our default program hoops worked well in our design testing. Please 
embroider some test designs with the desired hoop before tackling a final project. This 
will ensure that you have a reasonable Compensation setting for your specific project. 

~ Remember a LITTLE goes a long way! 

 Color-by-Color: denotes a different type of file splitting. At the current version of the 
program and time, only the Viking Mega Hoop™ (a multi-position hoop) allows for 
this type of design splitting, so as a general rule, never check this box unless you’re 
using this hoop.  

~ The Color-by-Color method is for use in machines that can sew each color in all of the 
hoop regions before going on to the next color. When the machine operates this way, it 
will stitch in its current region until it no longer can. It will then stop and ask the user to 
reposition the hoop, it will continue stitching.  
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~ Because of how this works it can cause a lot of position switching as a specific color 
typically stitches objects out in a random fashion all over the design. The program will 
automatically ‘sort’ the stitch objects to reduce the number of position-switches required 
when this option is selected. 

 Invert Alternate Column: this is used for “Double-Wide” hoops that get turned 
upside-down for their second row.  

 Add basting alignment lines: this option means that the program will automatically 
add basting alignment stitching lines to your design segments when saved.  

~ In design #1 the basting as the last thing to stitch; design #2 will have the basting stitch 
as the first thing that stitches. If there are more hoopings in that same Row or Column, 
then design #2 will also have basting alignment stitching as the last item to stitch too. If 
there are more in hoopings in the same Row or Column then this will continue in this 
manner. 

~ When stitching make sure the basting stitching lines, align at both the ends and/or center 
points on the fabric.  If the lines do not line up, then STOP stitching-restart your design-
adjust your hoop/fabric position. If they are off just a little, then use the design movement 
arrows on your machine. Keep checking and repeat the repositioning if needed until they 
aligned perfectly. 

 Baste Length: sets the stitch length of the alignment stitching line, in mm.  

~ Make this number larger (longer stitch length) if your fabric(s) is thicker. 

~ Make this number smaller (shorter stitch length) if your fabric(s) is thinner.  

 Default: this button will erase all the hoops you have created or edited and leave you 

with the hoops found originally in the program.  

Good to Know: 
 When you have more than 2 rows or 2 columns, then some of the split design 

segments will have more than one basting alignment stitches because they need to 
‘connect’ to more than one design section. You’ll see this in our exercise split design. 

 When you select a hoop from the 
Multi-Position Hoop Style list, the 
“Sewing Field” and “The design 
centers are offset from each 
other:” information is shown 
below the main hoop list. 

 The offset is displayed here in 
Centimeters (cm.). To convert to 
millimeters (mm), move the 
decimal one place to the right. 

Exercise: Creating a new hoop and splitting a design 
The design used in this exercise was created by using two different stitch files from Amazing 
Designs™ and using an EmbroideryWorks Advanced feature called “Carousel”. Each 
design was taken into Carousel separately, the circular layouts created and then the two 
separate circular layouts were combined into one file. To learn more about the Carousel and 
other fun design layout features, you’ll want to attend the “EmbroideryWorks™ -Fun Design 
Layouts and Appliqué” Sew at Home class.  



Sew at Home OnDemand Class: EmbroideryWorks Advanced – Fine-Tuning  25 

© 2013 Tacony Corp, all rights reserved   

1. Select the Open  icon. Locate the embroidery designs given with the class 
download.  

2. Select Scroll Carousel Layout.be design and click the Open.  

 Notice when the design came in, it opened automatically a new workspace/tab. 
 On the lower right side of the status bar notice: 

~ This file came in with the hoop I saved the working file with, 400mm x 300mm [15(3/4)" x 
11(13/16)"]. 

~ Overall size of the actual design. You need this information in millimeters. See the “Good 
to Know” on page 21 of this handout for steps on how to quickly convert this number. 

 We want to split this design using the Ellisimo/Ellisimo Gold large hoop, 200mm x 
300mm and so based on previously discussed information, we need to create a new 
hoop layout that is at least 295mm x 283mm or larger. 

3. Select the Preferences  icon.  

4. Select Multi-Position from the Hoop Style box. 

5. Select the New  button and the Hoop Properties box will display with a default 
“New Hoop” in the Hoop Name field. 

 

6. Make the following changes in the Hoop Properties box: 

a. Hoop Name: --type My:Ellisimo x 3 400x300 

b. File Type: --choose PES from the menu 

c. Individual Field Size (mm): --X: 200, Y: 300 

~  Notice the Overall Size values are changing as you type. 

d. Rows: –we’re going to leave this on 1 

e. Columns: --use arrows at the end of the field and change to 3 
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f. Offset: (mm) next to the Column: setting--type 100 

g. Offset: (mm) next to the Rows: setting--type 0 

~ Notice the Overall Size field information changed (306 mm x 200 mm). Now our design  

will fit in this new hoop layout.  

h. OPTIONAL: Compensation: change as needed. 

i. OPTIONAL: Baste Length: change as needed. 

j. Click the Save button. 

7. Select the My:Ellisimo x 3, 400 x 300 new hoop from the hoops list. 

8. Click the Apply  button and then the OK button. 

9. Use the Split into Hoop to preview how EmbroideryWorks Advanced will split the design 
using your new hoop. This feature is discussed in the “EmbroideryWorks™ Advanced –
Exploring the Utility Menu” Sew at Home class. 

a. Select the Utility menu and then Split into Hoop.  

~ Notice a new tab opens with the design split into 3 segments. 

~ DO NOT save this design page because the alignment bastign stitches and the text file 
will not be saved. 

10. Save your split design files: 

a. Select the Scroll Carousel layout.be tab again. 

b. Select the File menu and then Save As (Stitch and Working).  

c. Navigate to where you want to save the design using the Save in: window. 

d. Type your design name in the File name: field. Use Scroll Carousel in front of the 
automatic Split Design listed. 

e. Click the Save button.  

11. Now let’s look at what was created and saved: 

 5 files named: “Scroll Carousel Split Design Center 
#1.pes”; “Scroll Carousel Split Design Center #2.pes”; 
“Scroll Carousel Split Design Center #3.pes”; “Scroll 
Carousel.txt; and the “Scroll Carousel Split Design.be” 

 The #2 design also has 2 basting alignment stitches 
added because it has to ‘connect’ on either side. 
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Good to Know: 
 When you create a new multi-position hoop layout that 

has both rows and columns, EmbroideryWorks Advanced 
automatically adds perpendicular basting alignment 
stitches. See screen shot as an example. 

Other helpful suggestions for success: 

 Stitching of multi-fabric hooping designs can take some 
practice because you need to not only do you need to break 
your deign into pieces [EmbroideryWorks does that for you], but you also need to be 
very accurate in placing your design segments in each of the re-hoopings.  

 Most machines will give you the ability to display a grid behind the hoop on the screen. 
You can count the grids (usually 1 grid = 10mm) between the region marks to get the 
separation. 

 It is highly suggested you print a placement template for each separate split design 
segment. Information on printing templates is discussed the “EmbroideryWorks Basics - 
Part 2” Sew at Home class, available both as Live or OnDemand/recorded. 

 It may be helpful to recolor the segment that contains the basting alignment stitches to 
make them easier to see on the printed template and/or your fabric. 

 If your machine has a Needle Cam™ or Sensor Pen, you will want to use that 
technology to help position where you are going to stitch your split design segments. 

 Color Sort feature and design splitting information: 
 If you are using the same design repeated in your overall layout or the same exact 

thread color, you will want to use the Color Sort option on overall design layout 
BEFORE splitting. Color sorting may alter the way EmbroideryWorks splits a design 
because the stitching order and thread layering would be affected. 

 When you use Color Sort feature and Save button, you are saving just the stitch file 
and not the working file (.be). If you have already selected a Hoop Style: Multi-
Position then the Color Sort save will save the machine formatted split design 
segments automatically. 

 DO NOT Color Sort the individual split segments because the design layering may be 
incorrect and you’ll end up with it not stitching out correctly. 

 The use of ‘floating’ techniques for hooping can be helpful for repositioning quickly: 
 Not actually hooping the material itself, but rather hooping a stabilizer and attaching 

the fabric to stabilizer in some other manner. This will provides the least amount of 
distortion in the fabric while the overlapped regions of the design are being 
embroidered.  

 You can use an adhesive type stabilizer; spray adhesive, and/or a basting stitch to 
secure the design to the stabilizer. 

 It is very important to mark your fabric before starting any embroidering. When the fabric 

is re‐hooped it must be parallel and centered to the first hooping, so by marking a few 
vertical and horizontal lines on your fabric it will help you keep things straight…like 
horizon lines. 
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Deleting a hoop from the list:  

If you ever want to remove any of the Normal or Multi-Position Hoop Styles you have 
created, follow these basic steps. 

Exercise: Deleting a hoop 

1. Select the Preferences   icon.  

2. Select Normal or Multi-Position from the Hoop Style box, if not already selected. For this 
exercise select Normal. 

3. Select the hoop you want to remove from the main list. For this exercise select My 
Layout: 300 x 400. 

4. Select the Delete  button and the New Hoop box will display. 

 Notice now this hoop is no longer in the main list. 

Closing EmbroideryWorks: 
There are two ways to close the program. 

1. Select the X in the upper right corner of the program screen.  

OR  

2. Select File menu, then Exit from the drop down menu. 

Additional support materials available: 

 Online tutorial/projects using MasterWorks II on the Designer’s 
Gallery website: www.designersgallerysoftware.com 

 Also check the “Downloads” page on the Designer’s Gallery® 
website for free updates to your program. 

Good to Know: 
 Under the Help menu, you can ‘ask’ EmbroideryWorks to check if your program is 

up-to-date by selecting Check for Updates… 
option.  

 When opened, if your computer is online, it will 
check if there is an update available. A message 
will display letting your know to go download the 
update from the Designer’s Gallery website: 
www.designersgallerysoftware.com 

 Current and future Sew at Home On Demand and/or Interactive Online classes with 
more EmbroideryWorks functions discussed: 
 Link for the OnDemand/recorded class website: www.sewathomeclasses.com/ 
 Link for the Interactive/live class website: www.babylock.com/sew-at-home/  
 EmbroideryWorks Basics – Part 1 & 2, if you have not already taken them 

http://www.designersgallerysoftware.com/
http://www.designersgallerysoftware.com/
http://www.sewathomeclasses.com/
http://www.babylock.com/sew-at-home/
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 EmbroideryWorks – Lettering                                                                               
(for both EmbroideryWorks Everyday and EmbroideryWorks Advanced owners) 

 EmbroideryWorks – Fun Design Layouts and Appliqué                                       
(for both EmbroideryWorks Everyday and EmbroideryWorks Advanced owners) 

 EmbroideryWorks Advanced – Exploring the Utility Menu 
 Jumbo Hoop in Designer’s Gallery 

 Learning Guides: These are comprehensive lessons, in 
professionally printed spiral bound booklet form. They are based 
on the Sew at Home class of the same name. Learning Guides 
can be purchased at your Baby Lock® dealer or through the 
Designer’s Gallery® website. 
http://www.designersgallerysoftware.com/products/learning-
tools/learning-guide/  

 EmbroideryWorks Basics  

http://www.designersgallerysoftware.com/products/learning-tools/learning-guide/
http://www.designersgallerysoftware.com/products/learning-tools/learning-guide/

